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“Installing Microsoft Outlook Express”

This document has some hints and tips for installing and using Microsoft Outlook Express (OE).

INSTALLING MICROSOFT OUTLOOK EXPRESS 4.5
Installing Microsoft Outlook Express 4.5 is very simple. Whether you have obtained the software
from the internet or on a CD-ROM you will have a “Microsoft Internet 4.5.smi” file. This is an
Apple Disk Copy “Self Mounting Image” and to install the software follow these simple steps:

Step 1: Double click on the “Microsoft Internet 4.5.smi”
icon. The ‘self mounting image’ should verify. If
this verification fails the image may be corrupted
and you might need to download the image again or
obtain another CD.

Step 2: You will get the license agreement window (see
right). You are advised to read this license before
clicking on the “Accept” button.

Step 3: Double click on the mounted “Microsoft Internet
4.5” volume icon (on the right hand side of your
screen) and you will see a window similar to the one
to the right.

Note: If you are reinstalling Outlook Express 4.5 you
must double click on the “IMPORTANT” text file
and follow the instructions detailed in that file
before proceeding.

Step 4: To install OE 4.5 simply drag the “Microsoft Internet 4.5” or “Outlook Express 4.5”
folder from this window to your hard disk icon. Make sure the hard disk icon goes dark
before your let go of the mouse button. This will copy the relevant files to your hard disk.

Step 5: The final step to installation is to launch (run) OE 4.5 from your hard disk. Double click
on your hard disk icon, then double click on the “Microsoft Internet 4.5” or “Outlook
Express 4.5” folder and then double click on the “Outlook Express 4.5” application icon.
This will force a “first run” installation and Outlook Express which will install itself and
start running.

Note: If you get any messages at this point, about files already being installed (likely if you have
Microsoft Office 98 or older versions of Internet Explorer/Outlook Express installed) then
when it asks whether to install the “older” or “newer” versions always select “newer”.

INSTALLING OLDER VERSIONS OF OUTLOOK EXPRESS
Microsoft recommends only installing Outlook Express from an original installer. Outlook Express
can be installed using a separate installer or using the Internet Explorer 4.x’s “Recommended” or
“Full” installers. The following are the four main steps to installing Outlook Express. If you have
problems installing the software or need information on the different versions see the FAQ section.

Step 1: Double click on the installer’s icon. You will get the license agreement window (similar to
the one pictured above). You are advised to read this license before clicking on the
“Accept” button.

Note: With older installers options are available at this point to print the license agreement
and/or save it as a text file.



Mac OS Internet Customer Help Sheet No.15
“Installing Microsoft Outlook Express”

Step 2: You will now get the main installation window
(similar to the one pictured to the right). Make sure
the disk selected in the bottom left hand corner is
the correct disk for the software to be installed to.

Note: At this point the pop up menu in the top left is set
to “Easy Install”. This can usually be changed to
“Custom” which allows you to choose which
components are installed.

Step 3: When you are ready click on the “Install” button in the bottom right hand corner and
follow the on screen instructions.

Note: OE will ask you whether you want to make OE your default email package. In most cases
you should click “Yes”. If the installer says there are Microsoft components already
installed and which do you wish to keep ‘older’ or ‘newer’ always click on “Newer”.

Step 4: When OE has finished installing you should restart your Macintosh. Do not delete the
installer as you may need to use in the future.

Step 5: If you have installed Microsoft Outlook Express 4.01 you are now recommended to install
the “Outlook Express 4.02 Updater”.

SETTING UP OUTLOOK EXPRESS
If you are going to use Outlook Express on a Microsoft Exchange Server network we recommend
following the steps in Internet Help Sheet No. 18 “Setting Up Microsoft Outlook Express On An
Exchange Server”.

Step 1: When you first use Outlook Express it will ask you
for the default email account. This will usually be a
POP account but check with your Internet Service
Provider (ISP) or network administrator for
confirmation.

Step 2: Outlook Express will then ask you for your
email and newsgroup settings (see right). If it
doesn’t ask you automatically or you wish to
setup/modify the details select “Preferences”
from the ‘Edit’ menu.

Note: If you have installed the Apple Internet
Connection Kit [AICK] (using Internet Help
Sheet 4 “Installing The AICK”) your email
and newsgroup settings should already be
setup. Use the following procedure to check
your settings.

Step 3: Click on “Email” on the left hand side of the window and you should see a screen like the
one above. Now fill in/check your details as given to you by your ISP or network
administrator.



Mac OS Internet Customer Help Sheet No.15
“Installing Microsoft Outlook Express”

Step 4: Click on “News” on the left hand side of the
window and you should see a screen like the
one to the right. Now fill in/check your
details as given to you by your Internet
Service Provider (ISP) or network
administrator.

Note: You may just want to run through the rest of
the preference options so that you can set
Outlook Express up exactly how you want it.

FREQUENTLY ASKED QUESTIONS
Q. What version of Outlook Express should I use?
A. So far these are the different versions of Outlook Express for Macintosh:

Version Recommended Action
4.0a, 4.0b, 4.0c All of these are early versions of Outlook Express. Microsoft recommends that

you remove the older version and then install version 4.01 or if you have a
PowerPC Macintosh version 4.5. To upgrade to 4.01 or 4.5 you must remove the
older version of Outlook Express before using the newer installer. Note: you will
need to backup your email before doing this (see the FAQ section below for
more details on doing this).

4.01 If you have a PowerPC Macintosh you are recommended to upgrade to version
4.5. Note: you will need to backup your email before doing this (see the FAQ
section below for more details on doing this).

4.5 This is the current version of Outlook Express and can be downloaded free of
charge from the Microsoft web site.

Q. I’ve installed Outlook Express 4.0x. Can I move the application?
A. The OE application should be kept in the “Outlook Express 4.0 Folder” and this folder should be
kept in the “Microsoft Internet Applications” folder. For ease of use we suggest creating an alias to
the application or its folder.

Q. I use the Apple Internet Connection Kit. How do I put Outlook Express 4.0x in the
Launcher window?
A. Go to the Apple Menu and select “Launcher” from the ‘Control Panels’ sub-menu. Click on the
“Internet Kit” button on the left of the launcher. Now double click on your hard disk icon, double
click on the “Microsoft Internet Applications” folder and then double click on the “Outlook Express
4.0” folder. Now drag the “Outlook Express 4.0” icon on to the Launcher window and let go. A
button for Outlook Express should appear.

Note: If you wish to delete buttons from the Launcher window just hold down the option key (alt)
and drag the relevant button to the wastebasket (make sure your wastebasket icon goes dark before
you let go of the mouse button).

Q. Where can I get anti-virus software from?
A. “Norton Anti-Virus” is available from Symantec (01628 592222 – www.symantec.com/uk).
“Virex” is available from Dr. Solomon’s Software (01296 318700 – www.drsolomons.com).
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Q. I am having problems installing Outlook Express?
A. There are a number of reasons why Outlook Express may have problems installing. Follow these
steps in order. After each step try to install Outlook Express.

Step 1: DISABLE SYSTEM EXTENSIONS: Restart your computer holding down the shift key.
You should get a message saying that extensions are disabled/off. When the Mac has
started up remove any files from previous installations/versions of OE (see below).

Step 2: CHECK YOUR HARD DISK: Run Apple’s “Disk First Aid” utility (or similar e.g.
“Norton Disk Doctor”) to check the integrity of your hard disk.

Step 3: RUN VIRUS SOFTWARE: Check your Macintosh out with an anti-virus application such
Symantec’s “Norton Anti-Virus” or Dr. Solomon’s “Virex”.

Step 4: TURN OFF/DISCONNECT EXTERNAL SCSI DEVICES: This will eliminate possible
problems/conflicts with SCSI devices, the SCSI chain and/or incorrect termination.

Step 5: INSTALL USING A DIFFERENT COPY OF THE INSTALLER: The installer you are
using may be corrupt or damaged. If possible obtain another ‘fresh’ copy of the installer.
If you downloaded the installer as a “.bin” or as a “.hqx” file try downloading it again.

Step 6: REBUILD THE DESKTOP: A damaged desktop is usually indicated by generic icons
appearing and/or applications/files failing to open. The desktop file may be damaged
without these signs though so try rebuilding it by restarting your computer and holding
down the command-option keys (apple-alt) until you get the message “Are you sure you
want to rebuild the desktop?”. Then click on the “OK” button.

Step 7: CLEAN INSTALL SYSTEM SOFTWARE. Apple (0990 127753) can help you to do this.
Step 8: UPDATE SYSTEM SOFTWARE: Only if recommended (see below). Install the update

on top of a clean system (see step seven above).To check which version you have select
“About This Macintosh” or “About This Computer” from the ‘Apple’ menu. It will tell
you your system software version here.

If Your System Version Is Recommended Action
B1-7.1, B1-7.1.1, B1-7.1.2 Upgrade the OS or install Open Transport 1.1.2.
B1-7.5, B1-7.5Px Upgrade using System 7.5 Update 2.0.
B1-7.5.1, B1-7.5.2, B1-7.5.3 Upgrade using System 7.5 Update 2.0.
B1-7.5.3 Update B1-2.0 You have the option of installing System 7.5.5 Update.
B1-7.5.3 Revision 2.x You have the option of installing System 7.5.5 Update.
B1-7.5.5 No action required.
B1-7.6 Upgrade using Mac OS 7.6.1 Update.
B1-7.6.1 No action required.
B1-8.0 Upgrade using Mac OS 8.1 Update.
B1-8.1 No action required.
B1-8.5 Upgrade using Mac OS 8.5.1 Update.

Step 9: ERASE CLEAN INSTALL SYSTEM SOFTWARE. Apple (0990 127753) can assist you
in doing this.

Step 10: CONTACT MICROSOFT TECHNICAL SUPPORT: If Outlook Express still fails to
install make a note of what steps you have followed and any (error) messages that have
appeared before contacting Microsoft technical support.
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Q. I used just an Outlook Express 4.0x separate installer. How do I remove Outlook Express?
A. Follow these steps to remove Outlook Express:

Step 1: Run the installer you used to install Outlook Express.

Step 2: At the main installation window change the “Easy Install” pop-up menu to “Remove”.

Step 3: Select the disk that Outlook Express was installed on to (in the bottom left hand corner).

Step 4: Click on the “Remove” button in the bottom right hand corner.

Step 5: Follow the on screen instructions.

Note: This procedure will delete all the email messages and email address books that you have.

Q. I have Mac OS 8.5. How do I remove the Outlook Express 4.01 that came with it?
A. As this version of Outlook Express is actually bundled by Apple for use with Mac OS 8.5 the
technical support for removal and reinstallation is supplied by Apple UK. Contact the Apple
Assistance Centre on 0990 127753.

Q. I haven’t got any other Microsoft software. I have custom installed OE on its own using the
Internet Explorer 4.0x installer but I no longer wish to use OE. How do I fully remove it?
A. In this case it is advisable to remove the whole of OE manually. Follow these steps to do this.

Step 1: Double click on the hard disk icon and move the “Microsoft Internet Applications” folder
to the wastebasket.

Step 2: Double click on the “System Folder” and then move the “MS Internet Cache” and “MS
Preference Panels” folders to the wastebasket.

Step 3: Double click on the “Extensions” folder and move the following items to the wastebasket
(if they exist):

“ActiveX Controls” (folder)
Microsoft Component Lib (68k)
Microsoft Component Library
“MS Library Folder” (folder)
“MS Preference Panels” (folder)

Step 4: Close all the open windows and empty the wastebasket (using “Empty Wastebasket” from
the ‘Special’ menu).

Note: This procedure will delete all email messages and email address books that you have.

Q. What is Internet Config?
A. Internet Config is a third party utility that helps keep all your internet configuration details in
one place. Microsoft recommends having this utility installed on your Macintosh if you are using
Microsoft’s internet products such as Internet Explorer and Outlook Express. These Microsoft
products (except IE 2.x) will install Internet Config for you unless you have an Internet Config
folder in the root directory of your hard disk. To check for this double click on your hard disk icon
and look for a folder called “Internet Config”. If you do not have one, the utility will be installed for
you. However, please note Microsoft applications will only check this (recommended) location. It
will not check the rest of your hard disk. Other applications or even the Mac OS may install Internet
Config elsewhere on your hard disk. Microsoft recommend checking your hard disk and removing
duplicate copies of Internet Config if you have them.
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Q. I am using Internet Explorer but installed Outlook Express later. How do I make Outlook
Express my default email package?
A. This can be done by following this procedure:

Step 1: Start the Internet Explorer application and then select “Preferences” from the ‘Edit’ menu.

Step 2: Under the ‘Network’ heading click on “Protocol Helpers”.

Step 3: Click “Mailto”, click “Change” and then click “Choose Helper”.

Step 4: In the ‘Protocol Helper Editor’ dialog box, click “Outlook Express” and then click
“Open”.

Step 5: Click “OK” and then click “OK”.

Q. How do I import address books into Outlook Express?
A. Outlook Express has import capabilities built in. If you wish to use this feature of OE it can be
done by following this procedure:

Step 1: Start the Outlook Express application and then select “Contacts” from the ‘Windows’
menu.

Step 2: Select “Import -> Contacts” from the ‘File’ menu.

Step 3: Select the application you are going to import the address book from.

Step 4: It will ask you to locate a folder relevant to the application you are going to import the
address book from. Locate this folder and highlight.

Step 5: Click on the “Select xx Folder” button.

Note: Outlook Express 4.x can import address books from Internet Mail And News 3.x, Eudora
Pro, Eudora Light, Claris Emailer, Netscape Navigator and Netscape Communicator.

Q. I have Mac OS 8.5 and I prefer to use Netscape Navigator to browse the web. However, I
wish to use Outlook Express for email. Can I install Outlook Express without installing
Internet Explorer?
A. Yes. Outlook Express can be installed without Internet Explorer by using Mac OS 8.5’s Internet
Access standalone installer. This can be found on the Mac OS 8.5 CD in the Software Installers >
UK > Internet Access folder. Just double click the ‘Installer’ icon and select “Custom install” from
the pop-up menu. From here you can simply select “Outlook Express” from within the “Microsoft”
heading. Alternatively you could download and install the newer Outlook Express 4.5.

Q. I am upgrading from Outlook Express 4.0x. How do I use all the email that I already have?
A. Outlook Express keeps your mail data in the folder called “OE User(s)”. This folder is kept in
the same folder as the Outlook Express application (currently on your hard drive in the “Microsoft
Internet Applications” folder). To utilise your mail with version 4.5, you must move the “OE
User(s)” folder from the Outlook Express 4.0 folder to the “Outlook Express 4.5 Folder”.

Q. I am reinstalling Outlook Express 4.5 but wish to preserve my email. What do I do?
A. Outlook Express keeps your mail data in the folder called “OE User(s)”. This folder is kept in
the same folder as the Outlook Express application (currently on your hard drive in the “Microsoft
Internet 4.5” folder). To preserve your mail, you must be sure that the “OE User(s)” folder is NOT
overwritten. To do so, follow these steps carefully:
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Step 1: Locate the folder called “Outlook Express 4.5” or “Microsoft Internet 4.5” on your hard
disk and open it. Inside the “Outlook Express 4.5 Folder”, locate the folder called “OE
User(s)” and drag this folder to the desktop.

Step 2: Open the window that contains this text file and copy the folder that you see there to the
same location on your hard disk as your previous install. If you are installing both
Microsoft Internet Explorer and Microsoft Outlook Express, the name of the folder you
are copying is “Microsoft Internet 4.5”. (If you are installing only Outlook Express, the
name of the folder you are copying is “Outlook Express 4.5”.)

Note: When you are prompted to replace the current folder, click “OK”.

Step 3: Open the “Microsoft Internet 4.5” folder (or the “Outlook Express 4.5” folder) that you
just copied to your hard disk. Locate and open the folder called “Outlook Express 4.5
Folder”. Move the “OE User(s)” folder that you copied to the desktop in step one into the
“Outlook Express 4.5 Folder”.

Step 4: Double click the new Outlook Express 4.5 application icon to start it. Your mail will be
just as it was before you reinstalled Outlook Express.

Note: For advanced users: You can keep your “OE User(s)” folder anywhere on your hard disk
if you place an alias named “OE User(s)” in the folder that contains the Outlook Express
4.5 application.

PLEASE NOTE
• Microsoft strongly recommend that you backup any important data files before you attempt an

update install/restore of your system software especially any files you have in the “Documents”
folder (if you have one). To back up your files copy them to an external storage device such as a
second hard disk, Syquest or Zip/Jaz drive. If you don’t have any of these you will need to
backup your data on to floppy disks. If you have files that are larger than 1.4Mb you will need a
third party compression application like “Stuffit Deluxe” (from Aladdin), “Disk Doubler Pro”
(from Symantec) or the shareware utilities Stuffit Lite, Compact Pro or Zip It.

• Where third party software is mentioned this is not a recommendation or endorsement by
Microsoft and the information is offered as a guideline only. Microsoft cannot guarantee the
workings of any of the third party products or Apple software mentioned.

• Microsoft can only support customers that have valid support with us. Just because you have a
Microsoft product or customer number it does not automatically entitle you to support. If you
are unsure about the validity of your support ring 0870 5010100 and quote your customer ID.

MICROSOFT UK
Telephone Support: 0870 5010100 (please have your customer number ready)

Fax: 0870 5020200 (please list your name, telephone number and customer number on the fax)
UK Faxback Information Service: 0870 5030100

UK support on line: www.microsoft.com/uk/support


